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CHAPTER 2 – CARVING SIGNS AND 

LITHOPHANES 
 
The two most common uses for the CarveWright CNC, especially for new users, is 
to make signs and lithopanes.  We all know what a sign is, but what is a lithopane?  
A lithopane is an image carved into a translucent 
material that can only be seen clearly when back lit 
with a light source.  Both signs and lithopanes are 
easy to make with the CarveWright System and in 
this section we will show you how. 

What’s in this Section? 

This section will cover using basic drawing tools, 
text, depth & height, bit optimization, textures, and 
import image. These procedures will cover Project 
Designer BASIC, Project Designer PRO, Centerline Text, and Conforming Vectors. 

TUTORIALS 
Live Laugh Love Sign – This project also covers fine tuning & optimization of your 
project with depth, height, feathering & draft; use of the text tool, drawing tools, 
regions, textures, & carving list; changing the board settings and selection of 
quality settings. 

Spring Blooms Sign – Expanding on the “My First Carve” project using more Project 
Designer features, including text, regions, and textures. 

Winter Snowflake – Project that continues to introduce more tools, including the 
basics of optimization including feather and draft. 

Martian Ray Gun – Martian Ray Gun sign project reinforcing the features learned 
from previous tutorials. 

House Number Sign – This project adds instruction in using drawing tools, grids & 
snap to grid; adding constraints; using Centerline Text (sold 
separately) and Conforming Vectors (sold separately), copy & paste, flip & rotate, 
creating a closed regions & staying under the rollers. 

Importing Images – There are several different image file types that can be used to 
import logos, clipart, photographs, scanned drawings, and more. This Design 
Project aims to assist you in overcoming some of the basic challenges. 
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OVERVIEW OF TEXT TOOLS 
 

The text tools are used to place text onto your project board.  This text can be 
manipulated and carved using a variety of Rout modes. The Text Tool uses 
whatever True Type Fonts (.ttf) you have located in your font folder.  The fonts are 
not coming from Designer. Remember one of your computers may not have the 
save fonts as your other computer.  There are many fonts available online, but 
they may not all be ideal to carve and too many fonts may slow down your 
software. 

 

Open Project Designer and click on New Project. 

 

Put in the dimensions of the Project board. This needs to be the finished size of 
your project. Do not include the 7 inch margin required by the machine. (more on 
the 7 inch rule later in this lesson)

TRUE TYPE 
FONTS 

USING THE TEXT 
TOOL 
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Select the Text tool from the tool bar at the top of the screen and click anywhere 
on the project board. 

This will open the Text Tool window. This window is slightly different in Designer 
Basic and Designer PRO.  

 

 

 

 

NOTE: The Centerline option under Rout Mode is only available in Demo mode, if 
the Centerline Text Add-On Module has not been purchased and activated. 
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Using this text window to type whatever is wanted to appear on the board. For 
this tutorial, we are going to write the word “RASTER”, choose “Times New 
Roman” in the font selector, select “Bold” as a style, and choose the Raster “Rout 
Mode”. Click “OK” to complete and then we’ll see the text displayed on the board. 

 

This text has all the features of a pattern and can be adjusted in size, position, and 
depth the same as any other pattern. Being in Raster mode, this text will be carved 
out as a raster, line by line, the same as the carved patterns. 

Select the Text Tool again and click on the board to open it again. The Text tool will 
remember the font settings we used before, but this time we will write the word 
“OUTLINE”, and choose the outline “Rout Mode”. 

 

 

 

 

 

 

 

 

 

Click ok and this will display on the board. 
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The outlined text appears with a v-grooved outline around the text. This will be cut 
with a 90 degree V- bit by default as a vector function.  As a vector cut, the V-bit 
will trace around the letters rather than carving line by line like the raster. 

 

 

 

 

 

 

 

 

 

Select the Text Tool again and click on the board to open it again. Now we will 
write the word “CENTERLINE”, choose the Centerline “Rout Mode”, and click OK.  If 
you have not purchased and activated Centerline Text, this will be working in 
DEMO mode and will not be able to be carved. 

 

Centerline Text is an algorithm that calculates the centerline of the font and 
calculates the depth based on the width of those lines. It defaults to using a 90 
degree v-bit and will carve the letters as a vector path. You can change this to the 
60 degree v-bit using the Select Bit icon. 
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Since the depth of Centerline text is determined by the variations in width of the 
font, you cannot change the depth, except by changing the size.  Centerline is 
applied to the top surface of the board. If you wish to use Centerline within a 
carved region or on any surface below the top of the board, you will need the 
Conforming Vectors add-on. 

 

 

 

 

 

 

 

 

Now, double click on the word RASTER on your board.  This will open the Text Tool 
window again, allowing you to make edits to this piece of text.  Use the arc slider to 
curve the lettering, and try increasing the spacing.  Click ok, again, and the edited 
text will display with your new settings. 

Now that we are familiar with the text tools, you are ready to make a sign! 
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PROJECT OPTIMIZATION  
 
When creating projects in Project Designer, there are several steps necessary for 
optimizing the project for carving.  There are several tools used for this process, 
primarily they are: draft, feather, and bit optimization. 

 

Draft sets an angle from the outer top edge of raised carvings out to the base of 
the carving. It is  primarily used to reduce chip-out issues. There are 4 settings of 
draft to choose from for raster patterns or text. 

Draft None Removes any Draft settings 

 

Draft Small This sets a small angle to the outer top edge of raised 
carvings to reduce chip-out issues. 

 

Draft Medium This sets a medium angle to the outer top edge of raised 
carvings to reduce chip-out issues. 

 

Draft large This sets a large angle to the outer top edge of raised carvings 
to reduce chip-out issues. 

 

As an example, let’s create some raster text on a board and choose a font with thin 
lines. 

DRAFT 
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By default, the text has straight edges raising up from the 
base of the letter to the top surface. We call these straight 
edges “cliffs”.  The problem that can occur with these edges has to do with the 
taper of the carving bit that is used to carve these. This angle can carve away the 
top edge of the cliff when it is carving the bottom corner. (Figure 1) 

 

 

Figure 1: No Draft 
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Draft is used to add an angle to these outer edges to give clearance for the taper of 
the bit.  (figure 2) 

 

As an added benefit, the draft settings can also create 
a nice bevel to the outer edge that enhances the look of the design.  It’s not only 
functional, but it looks great too. 

 

Figure 2: Draft Small 
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This sets an angle projected up and out from the base of the patternʼs outer edge. 
Used for creating a transition from the top surface of the board to the base of the 
carving. There are four settings to choose from in Designer BASIC, and a custom 
setting in Designer PRO 

Feather None Removes any feather settings. 

 

Feather 1/8 This sets the degree of feathering to 1/8” 

 

Feather 1/4 This sets the degree of feathering to 1/4” 

 

Feather 1/2 This sets the degree of feathering to 1/2” 

 

Feather Custom (Designer PRO) This sets the degree of feathering to any 
dimension up to 1” 

 
Feathering can reduce wear on the machine and bits, by creating a smoother 
transition around carvings, especially for deep carvings. 

 

 

 
       

 
 
 
 
 
 

 
 
 
 
 
 
 

FEATHER 
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Feather – left to right = None, 1/8, 1/4, and 1/2" 
 
 
Flip Feather 
Carved regions, created with any of the drawing tools, can have their feathers 
either on the inside or outside of the line. The Flip Feather icon is only highlighted 
when a carved region is selected. 

 

   



 

64 | P a g e  
 

 
Sets the limit with which the bit carves into tight areas to preserve the top level 
detail. There are five settings to choose from optimizing your carvings. 

 

Bit Optimization: None Applies no bit optimization. 

 

Bit Optimization: Low Slightly, decreases the depth of the carve in tight areas. 

 

Bit Optimization: Medium Decreases the depth of the carve in tight areas at 
medium level. 

 

Bit Optimization: High Decreases the depth of the carve in tight areas at high level. 

 

Bit Optimization: Best Eliminates all top level detail thinning in tight carved areas. 

As an example lets import a photograph and place it on the board. Photographs 
are good example because of the large amount of individual pixels that can vary 
greatly in depth. Some of these pixels can be deep, but they are right next to high 
pixels, essentially creating a “hole”.  When the bit goes to carve this, it will cause a 
widening of that hole from the diameter of the bit. 

   

BIT 
OPTIMIZATION 
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FINE TUNING 
The adjustment of depth and height are essential tools for fine tuning your designs 
in Project Designer. These tools allow the creation of more intricate layering of 
patterns to create more visual interest in the design. 

 
Depth is describing the lowest level, or the base, of the carving, pattern or 
element.  Most patterns, when placed on the board, are set to be at 1/4” deep.  
With the depth tool, this depth can be changed to whatever depth desired within 
the limits of the bit. 

 
 
 

 
 
 
 

 

 

 

 

 

 

Below: Depth left to right .125”, .25” and .5” 

 

 

 

 

 

 

 

DEPTH 

Depth at .25” Depth at .5” 
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Height at 100 Height at 30 

This is a relative value of the height from the deepest part of the carving to the top 
of the board being used. It can be set from 0-999 with 999 being no material 
removed from the highest point of the element. It will default to 100, which is it’s 
original thickness. 

This basically means you can make a pattern taller or shallower within its set 
depth. The deeper the pattern is, the higher you can raise it since there is more 
distance to work with. 

 

 

Depth for each = .5”. (From left to right – height = 20, 50, 100, 999) 

 

 

HEIGHT 
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Depth and height when used together can create the effect of elements appearing 
to be behind or above other elements. 
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TUTORIALS 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
This project covers the following design concepts: 
 
Ø PATTERN PLACEMENT 
Ø PATTERN MANIPULATION 
Ø FINE TUNING 
Ø ADJUSTING DEPTH & HEIGHT 
Ø TEXT TOOL 
Ø DRAWING TOOLS 
Ø REGIONS 
Ø TEXTURES 
Ø CARVING OPTIMIZATION 
Ø FEATHERING 
Ø DRAFT  
Ø CARVING LIST 
Ø BOARD SETTINGS 
Ø MANAGING DATA 
Ø UPLOADING TO MEMORY CARD 
Ø QUALITY SETTINGS 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

LIVE LAUGH 
LOVE 
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INSTRUCTIONS: 
 

Ø STARTING THE SOFTWARE 
 

Open the CarveWright Designer 
Software 

 
The Welcome screen appears with 

project options.   
 

 
Select “New Project” 

 
 
 
 
 
 
 
 
 
 

Set your board piece dimensions.   
Length: 12” 

Width: 6”  
Thickness: .75”    

 
Click ok 

 
 
 
 
 
 
 
 
 

Ø MENUS, TOOLBARS OR 
MOUSE  
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Ø MANIPULATING THE 
WORKPIECE  

 
Board piece will display on screen 

in three dimensions. 
 

  Zoom 

  Rotate 

  Pan 

  Front 

  Rear 
 
 
 

Ø PATTERN PLACEMENT 
 

  Select the “pattern tool” to 
open the pattern library along the 

right side.  
 
 
 
 

Select “Grapes01” under “Fruits 
and Vegetables” in the Basic 

Library.  Click on board to place.  
 
 
 

Ø PATTERN MANIPULATION 
Use Red Nodes on the corner to 

Scale the pattern. 
 

Also, use the Green Node to 
Rotate the pattern 
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Ø PATTERN PLACEMENT & 
MANIPULATION 

 
Adding Additional Patterns 

 
Select “Vine04” under “Vines and 
Stems” in the Basic Library.  Drag 

and drop it onto the board. 
 

Rotate and scale to fit with other 
pattern.  

 
 

*****IMPORTANT***** 
Notice how the patterns overlap.  
The stem of the vine is surfacing 

through the grape pattern. 
 

Ø FINE TUNING 
 

To fix this we will adjust the depth 
and height.   

 
Ø ADJUSTING DEPTH 

Select grapes and change depth to 
“.125” or “1/8” inch. 

 
Change the vine depth to “.125 or 

1/8” inch.  This shallows the entire 
design for faster carving, but does 

not fix the overlap. 
 

Ø ADJUSTING HEIGHT 
 

Select the vine pattern and adjust 
the Height to “30”.  This lowers 

the overall thickness of the 
pattern. 

 
Notice the stem is gone. 
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Ø BOARD SETTINGS 
 

  Use “Toggle Texture” to 
remove wood grain for better 

viewing.   
 
 
 
 
 
 
 
 
 
 

 
Select “Vine06” from “Vines and 

Stems” in the Pattern Library and 
place onto board. 

 
 
 
 
 
 
 
 
 

Use the right-click button on the 
mouse to bring up menu of 

available options for that pattern. 
 
 
 
 

 
 Select “Flip & Rotate”- “Rotate 

Horizontally”. 
 

Scale pattern down and overlap 
with grapes. 
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Ø FINE TUNING 
Ø ADJUSTING DEPTH & 

HEIGHT 
 

Like other patterns, change the 
Depth to “.125” or “1/8” inch.   

 
Change the Height to “30” to 

match other vine pattern. 
 
 
 
 
 

ü TEXT TOOL 
 

 
Next, select the “Text Tool” and 

click on board. 
 

Text dialog box will appear. 
 

  Select from any of the true type 
fonts that you have on your 

computer. 
 

Type the word “Live” 
 

Select “Raster” from one of the 
available Rout Modes. 

 
Notice the other options available 

from “Text Tool”. 
 
 
 

Manipulate the size and 
placement of the word, just as you 
would a pattern by scaling up and 

overlapping with the vine. 
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Right Click on “Live” and select 
“Copy”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click on board, right click and 

select “Paste”. 
 
 
 
 
 
 
 
 
 

The word “Live” will appear again 
on the board.  Double click on 

word. 
 
 

Text dialog box will reopen. 
 

Change the word to “Laugh” and 
click “OK”. 
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The word “Laugh” will appear on 
the board the same size as “Love”. 

 
 
 

Move to place as shown. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click an open area of the board to 
unselect “Laugh”. 

 

 
Right click and select “Paste” 

again. 
 
 
 
 
 
 

The word “Live” from the 
clipboard will appear on the board 

again. 
 
 
 

Double click the word. 
 

When the Text dialog box appears, 
change word to “Love”. 

 
Move to place as shown. 

 
Click “OK”. 
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Right click on an open area of the 
board and choose “Select All”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notice the yellow dotted line 
around all patterns. 

 
This allows you to move 

everything together. 
 
 
 
 
 
 
 
 
 
 
 

Adjust the patterns so they are 
better centered on the board. 
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ü DRAWING TOOLS 
 

 
Select the “Rectangle Tool”. 

 
 

Draw Rectangle across the entire 
board, leaving a border as shown. 

 
 
 
 
 
 
 

ü REGIONS 
 

 
Select “Carve Region”. 

 
This applies a carved area to the 

rectangle with a default depth of 
.25”. 

 
 
 
 
 
 
 
 
 
 
 

Ø FINE TUNING 
Ø ADJUSTING DEPTH  

 
Change the Depth to “.125” to 

shallow this region to match the 
rest of the carvings. 
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Right click and select “Center 

Both”. 
 
 
 
 
 
 
 
 
 
 
 
 

Ø TEXTURE 
 

 
Click on “Select Texture”. 

 
 

Texture dialog box appears 
displaying a variety of available 

textures. 
 

Select “Checkering 2” and leave 
the interval at 1”. 

 
 
 
 
 
 

Texture appears in the rectangular 
region, but is overtaking parts of 

the design. 
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Ø FINE TUNING 
Ø ADJUSTING HEIGHT 

 
Correct this by adjusting the 
Height to “20”.  This sets the 

texture back enough to be more 
subtle. 

 
 
 
 
 
 
 
 
 
 

Ø MANIPULATING THE 
WORKPIECE  

 
 

 
Rotate and/or zoom your 

workpiece to see your design 
board more clearly. 

 
 
 
 
 
 
 

Ø CARVING OPTIMIZATION 
 
 

Ø FEATHERING 
 
 

 
With the rectangular region 

selected, click on the “Feather 
Tool”. 

 
From the drop down menu, select 

“Feathering ½ inch”. 
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Adding a feathered edge applies 
an internal bevel to the region.   

 
It helps to eliminate a straight up 

and down edge referred to as a 
“cliff edge”. 

 
 
 
 
 
 
 
 
 
 

Ø CARVING LIST 
 
 

 
Select “View” and then “Carving 

List” 
 

The Carving List opens on the left 
displaying every element on the 

virtual design board. 
 
 
 
 

These elements can be rearranged 
or selected in a variety of ways. 

 
 
 
 

Select the 3 text files by holding 
down the shift button and clicking 

on each of them. 
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Ø CARVING OPTIMIZATION 
 
 

Ø DRAFT 
 

 
Select the “Draft Tool” and choose 

“Draft Large”. 

 
 

This puts a bevel on the edge of 
the letters removing cliff edge. 

 
 

Ø FEATHERING 
 

 
Select the “Feather Tool” button 
again.  This time select “Feather 

None”. 
 
 

This removes the feather from the 
letters. 

 
 
 
 
 

Select the 3 patterns from the 
Carving List. 

 
 

 
Select “Draft” and choose “Draft 

Medium”. 

 
 
 

This slight bevel to the patterns 
aids in the removal of cliff edge. 
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Now select each element and 
adjust their placement until the 

design arrangement is 
satisfactory. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Toggle the Texture back on to see 
the design with wood grain again. 

 
 
 
 
 
 
 
 

Ø BOARD SETTINGS 
 

 
Select “Edit” then “Board Settings” 

to open the board setting dialog 
box. 
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In the Board dialog box choose the 
Stain/Finish tab. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Change the wood type to 
“Mahogany” and the finish to 

“High Gloss”. 
Click “OK”. 

 
 
 
 
 
 
 
 
 
 
 

The board’s appearance changes 
to look like a finished board.   

 
 

 
Rotate to view it at different 

angles. 
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Select “File”, “Save”  

 
*****IMPORTANT***** 

Name file and click “Save” to hard 
drive. 

 
 
 
 
 
 
 
 
 
 

Ø UPLOADING TO MEMORY 
CARD 

 
 

 
Select “File”, “Upload” 

 
 
 
 
 
 
 
 
 
 

Ø QUALITY SETTINGS 
 

Flash Manager dialog box appears.  
Set your quality setting to Best, 

Normal and then Draft to see how 
the estimated time to carve 

changes. 
  

Save to memory card. 
 

Example: 
livelaughlove_N_27 

(recognizable name_quality 
setting_estimated time to carve) 
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This project covers the following design concepts: 
 
ü OPEN PROJECT OR LAST PROJECT 
ü DRAWING TOOLS 
ü CENTERING 
ü CARVE REGION 
ü FEATHERING 
ü TEXTURES 
ü FINE TUNING 
ü ADJUSTING HEIGHT 
ü PATTERN PLACEMENT 
ü TEXT TOOL 
ü ADJUSTING DEPTH 
ü USING DRAFT 
ü BOARD SETTINGS 
ü MANAGING DATA 
ü UPLOADING TO MEMORY CARD  
ü SELECT QUALITY SETTING 
ü NAME PROJECT 

 
 
 
 
 
 
 
 
 

SPRING BLOOM 
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INSTRUCTIONS:  
 
ü STARTING THE SOFTWARE 
 
Open the CarveWright Project 
Designer Software 
  
The Welcome screen appears with 
project options. 
 
Select “Last Project” or “Open 
Project” (if you have done something 
else, since Project 1-12 “My First 
Sign”). 
 
 

ü DRAWING TOOLS 
 

 
Select the “Rectangle” tool. 
 
Click in top left corner and drag to 
subscribe rectangle area around the 
flower. 
 
Set the “Size” to 6” x 6” and hit Enter to 
apply. 
 
 
You could have also used the square tool 
for this. 
 
ü CENTERING 

 
With the rectangle selected, right‐click to 
bring up menu of available options. 
 
Select “Center” > “Center Both” 
 
 
ü CARVE REGION 
Click on the “Carve Region” icon. 
 
 This creates a carved out region inside 
the boundary. Automatically defaults to 
.250” depth.  Remember depth of pattern 
& how depth effects carve time. 
 
ü FEATHERING 
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Click on “Feather” dropdown tool and 
select ¼” feather. 
 
Select “Accept”. 
 
 
 
 
This produces a ramped area and allows 
you to avoid “cliffs” while using a 
tapered bit. 
 
 
 
 
ü TEXTURES 

 
Select “Texture” tool.  
 
Texture dialog box appears displaying a 
variety of available textures. 
 
Select “Vertical Wave” and leave the 
interval at 1” 
 
Texture appears in the rectangular 
region, but is overtaking parts of the 
design. 
 
 

 
 
ü ADJUSTING HEIGHT 
 
 
 
Correct this by adjusting the Height of 
the texture to “20”.   
 
This sets the height low enough to not 
overpower the foreground objects. 
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ü PATTERN PLACEMENT 
 

Open Pattern Library and click: 
  
+ sign to open Favorites then  
+ sign to open Seasons then  
+ sign to open Spring pattern folder.   
 
 
 
 
 
 
 
 
 
 
 
 
Select “Grass” pattern and place onto 
board as shown. 
 
 
 
 
 
 
 
 
 
 
ü CENTERING 
 
Right-click to see available options and 
select Center > Horizontally. 
 
 
 
 
 
ü ADJUSTING HEIGHT 
 
Change Height of grass to 30. 
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ü FEATHERING 
Change Feathering to None. 
 
 
 
Make necessary adjustments to leaves or 
grass. 
 
 
ü TEXT TOOL 
 
Next, select the “Text Tool” and click on 
board. 
 
Text dialog box will appear.  Select from 
any of the true type fonts that you have 
on your computer.  Some work better 
than others. 
 
Type the word “Spring” 
 
Select “Raster” from one of the available 
Rout Modes. 
 
Notice the other options available from 
“Text Tool”. 
 
ü FINE TUNING  
 
Manipulate the size and placement of the 
word, just as you would a pattern by 
scaling to size. 
 

ü CENTERING 
 
Right-click to see available options and 
select Center > Horizontally. 
 
ü ADJUST DEPTH 

 
Set depth to .25” 
ü ADD DRAFT 
 
Select “Draft” drop-down menu and 
change to Medium. 
 
Draft gives a ramped area for the carving 
bit and avoids “cliffs” that may lead to 
chip out.  Reducing the Height of the text 
may also help. 
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ü BOARD SETTINGS 
 
Use “Toggle Texture” to remove wood 
grain for better viewing. 
 
 

 
Rotate or zoom in on your project to view 
it from different angles and make any 
necessary adjustments. 
 
 
 
 
 
 
 
ü MANAGING DATA 
 
Select “File” > “Save” 
 

*****IMPORTANT***** 
Once a project is uploaded to a memory 
card, it cannot be brought back from the 
memory card into the software.  Always 
SAVE YOUR PROJECT on your hard drive.  A 
Projects folder is recommended and you 
should know where you saved it. 
 
 
 
 
 
 
ü UPLOADING TO MEMORY CARD 
 
Make sure your Memory Card 
 & Programmer are properly attached via 
your USB port, Select “File” > “Upload” to 
save to your memory card. 
 
Select Quality Setting  
 
Ø DRAFT 
Ø NORMAL 
Ø BEST 
Ø OPTIMUM 
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These settings determine the number of 
passes the machine makes to carve your 
project.  The more lines the better the 
surface  finish.  Make your decision based 
on material type, fondness of sanding vs. 
machine time, & test carve vs. final.  Notice 
the estimated carving time differs by 
quality setting. 

 
Name Your Project  
 
Example: 
springbloom_N_45m 
(recognizable name_quality 
setting_estimated time to carve) 
 
Click “Upload” 

 
NOTE: Actual board to be placed in machine should be 7” longer or you should use a sled that has 3.5 extra inches on 
each end to STAY UNDER THE ROLLERS. 
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This project covers the following design concepts: 
 
ü STARTING SOFTWARE 
ü MENUS, TOOLBARS, SHORTCUT KEYS OR MOUSE BUTTONS 
ü MANIPULATING THE WORKPIECE 
ü SNAP TO GRID 
ü DRAWING TOOLS 
ü CARVE REGION 
ü FEATHERING 
ü PATTERN PLACEMENT 
ü ROTATE ELEMENT 
ü COPY & PASTE 
ü ADJUSTING HEIGHT 
ü TEXT TOOL 
ü FINE TUNING 
ü ADJUSTING DEPTH 
ü TEXTURE 
ü BOARD SETTINGS 
ü MANAGING DATA 
ü UPLOADING TO MEMORY CARD  
ü SELECT QUALITY SETTING 
ü NAME PROJECT 

 
 

 
 
 
 
 
 
 
 
 

WINTER 
SNOWFLAKE 
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INSTRUCTIONS:  
 
ü STARTING THE SOFTWARE 
 
Open the CarveWright Project 
Designer Software 
 
The Welcome screen appears with 
project options.   
 

 
Select “New Project” 
 
 
 
 
Set your project board dimensions.   
Length: 7” 
Width: 7”  
Thickness: .75”    
 
Click OK 
 
 
The project board size is not necessarily 
the actual size of the board being put 
into machine. 
  
 
 
 
 

ü MENUS, TOOLBARS, SHORTCUT 
KEYS OR MOUSE BUTTONS 

 
For every software function, we 
provide you three distinct ways to 
access that function.  They are usually 
menu, icon or right-click. Some 
common functions, such as Copy and 
Paste, also use shortcut keys.  These 
will also work in Project Designer. 
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ü MANIPULATING THE WORKPIECE  
 

Board piece will display on screen in three 
dimensions.  You can use these tools to 
get a different view of your project board. 
 

  Zoom 

  Rotate 

  Pan 

  Front 

  Rear 
 

 
 
ü SNAP TO GRID 
 
Under LAYOUT menu, select SNAP. 
 
 
 
 
 
 
 
 
 
 
 
 
Snap Interval should be .5 inch interval by default. 
 
Check boxes: 
• Snap to grid 
• Snap to edges 
• View grid 
• View Bezier Control Points (should already be 

selected as default) 
 

Click ok 

 
 
 
 
 
 
 



 

96 | P a g e  
 

ü DRAWING TOOLS 
 
Using the grid, draw a box or rectangle .5” 
inside the project board, which should 
give you a box that is 6” x 6”.  
 
Select the “Pattern Tool” icon to open the 
pattern library along the right side. 
 
 
 
 
 
 
 
 
 
ü CARVE REGION  
 
Select “Carve Region” icon. 
 
 
This creates a carved out region inside the 
boundary. Automatically defaults to .250” 
depth.  Remember depth of pattern & how 
depth effects carve time. 
 
 
 
 
 

 
 
 
ü FEATHERING 
 
Select the drop-down Feather menu and 
select ¼” feather. 
 
Select “Accept” 
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ü PATTERN PLACEMENT 
 
 Select the “Pattern Tool” icon to open the 
pattern library along the right side. 
 
Select “snowflake” under “Season Patterns” 
in your Favorites library from the winter 
folder. 
 
Click once on pattern and once on board to 
place or click and drag to the board. 
 
Double-clicking will attempt to open it in 
Pattern Editor Software. 
 
 
 
Set depth of snowflake to .250”. 
 
 
 
 
 
 
 
 
 
 
 
ü ROTATE ELEMENT 

 
Click on the green knob of the 
“Rotate” bar in the center of the element. 
 
Rotate snowflake.   
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ü PATTERN MANIPULATION 
 
 
Use Red Nodes on the corner to Scale the 
element larger or smaller.   
 
Yellow nodes will stretch or skew the 
element. 
 
 
 
 
 
ü SNAP TO GRID 
 
Click “Toggle Snap to Grid” icon to turn grid 
OFF. 
 
 
 
ü COPY & PASTE 
 
With the snowflake selected, right-click and 
select copy. 
 
Right-click again and select paste. 
 
 
 
 
 
 
 
ü PATTERN MANIPULATION 

 
Use Red Nodes on the corner to Scale the 
element smaller.   
 
Use Rotate knob to rotate the 
pattern. 
 
ü ADJUSTING HEIGHT 
 
Set the Height to .50. 
 
Adjusting height is useful in making the 
same elements look like they are behind or 
in front of other objects.  
 
 
 



 

99 | P a g e  
 

ü COPY & PASTE 
 
Right-click again and select “Paste”. 
 
Since the last thing you copied was the 
snowflake, you do not need to copy it, 
again.  It is still on your “Clipboard”. 
 
 
 
ü PATTERN MANIPULATION 
 Manipulate the pattern, again, 
changing the rotation & size of it until 
you have it arranged as you would like. 
 
ü TEXT TOOL 

 
Next, select the “Text Tool” and click on 
board. 
 
Text dialog box will appear.  Select from 
any of the true type fonts that you have 
on your computer.  Some work better 
than others. 
 
Type the word “Winter” 
 
Select “Raster” from one of the 
available Rout Modes. 
 
Notice the other options available from 
“Text Tool”. 
 
ü FINE TUNING  
 
Manipulate the size and placement of 
the word, just as you would a pattern by 
scaling to size. 
 
ü CENTERING 
 
Right-click to see available options and 
select Center > Horizontally. 
 
ü ADJUST DEPTH 
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ü TEXTURES 
 

Select “Texture” tool.  
 
Texture dialog box appears displaying a 
variety of available textures. 
 
Select “Peaks” and leave the interval at 
1” 
 
Click OK. 
 
 
 
 
Texture appears in the rectangular 
region, but is overtaking parts of the 
design. 
 
ü ADJUSTING HEIGHT 

 
Correct this by adjusting the Height to 
“10”.   
 
This sets the height low enough to not 
overpower the foreground objects. 
 
 
 
 
ü BOARD SETTINGS 
 
Go to View > Toggle Texture to remove 
wood grain for better viewing. 
 
Also look at View > Board Settings > 
Stain/Finish to see how you can change 
the Wood Type/Stain or Wood Finish.  
This is a great way to present a proposal 
to a potential customer. 
 

 
Rotate or zoom in on your project to 
view it from different angles and make 
any necessary adjustments. 
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REMEMBER THESE FUNCTIONS FROM PREVIOUS STEP-BY-STEP PROJECTS 
 
 
ü MANAGING DATA 
 
Select “File” > “Save” 
 

*****IMPORTANT***** 
Once a project is uploaded to a memory card, it cannot be brought back from the memory card into the software.  
Always SAVE YOUR PROJECT on your hard drive.  A Projects folder is recommended and you should know where you 
saved it. 
 
ü UPLOADING TO MEMORY CARD 
 
Make sure your Memory Card 
 & Programmer are properly attached via your USB port, Select “File” > “Upload” to save to your memory card. 
 
Select Quality Setting  
 
Ø DRAFT 
Ø NORMAL 
Ø BEST 
Ø OPTIMUM 

 
These settings determine the number of passes the machine makes to carve your project.  The more lines the better the 
surface  finish.  Make your decision based on material type, fondness of sanding vs. machine time, & test carve vs. final.  
Notice the estimated carving time differs by quality setting. 

 
Name Your Project  
 
Example: 
winterflake_B_1h45m 
(recognizable name_quality setting_estimated time to carve) 
 
Click “Upload” 

 
NOTE: Actual board to be placed in machine should be 7” longer or you should use a sled that has 3.5 extra inches on 
each end to STAY UNDER THE ROLLERS. 
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This project covers the following design concepts: 
 
ü STARTING SOFTWARE 
ü MENUS, TOOLBARS, SHORTCUT KEYS OR MOUSE BUTTONS 
ü DRAWING TOOLS 
ü CENTERING TOOLS 
ü CARVE REGION 
ü PATTERN PLACEMENT 
ü CREATING A RAISED REGION 
ü CHANGE DISPLAY 
ü TEXT TOOL 
ü USING THE CARVING LIST 
ü CREATING A TEXTURE 
ü GROUP PATTERNS 
ü MANAGING DATA 
 

 
 
 
 
 
 
 
 
 
 
 

MARTIAN RAY GUN 
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INSTRUCTIONS:  
 
ü STARTING THE SOFTWARE 
 
Open the CarveWright Project Designer 
Software 
 
The Welcome screen appears with 
project options.   
 

 
Select “New Project” 
 
 
 
 
Set your project board dimensions.   
Length: 15” 
Width: 10”  
Thickness: 0.75”    
 
Click OK 
 
 
The project board size is not necessarily the 
actual size of the board being put into 
machine for carving. 
  
 
 
 
 
 
 
ü MENUS, TOOLBARS, SHORTCUT KEYS 

OR MOUSE BUTTONS 
 
For every software function, we provide 
you three distinct ways to access that 
function.  They are usually menu, icon or 
right-click. Some common functions, such 
as Copy and Paste, also use shortcut keys.  
These will also work in Project Designer. 
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ü DRAWING TOOLS 
 
Using the rectangle tool create a box on 
the front face of the work piece.  
 
Resize the box to be 12” long and 7” tall 
using the Sizing box found on the toolbar. 
 
 
 
 
 
 
 
 

 
 
ü CENTERING TOOLS 
 
With the rectangle selected, right‐click to 
bring up menu of available options. 
 
Select “Center” > “Center Both” 
 
 
 
 
 
 
 
 
 
 
ü CARVE REGION  
 
Select “Carve Region” icon. 
 
 
This creates a carved out region inside the 
boundary. Automatically defaults to .250” 
depth.  Remember depth of pattern & how 
depth effects carve time. 
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ü PATTERN PLACEMENT 
 
 Select the “Pattern Tool” icon to open the 
pattern library along the right side. 
 
Select “Raygun” under “RaygunProject” 
folder in your Favorites. 
 
Click once on pattern and once on board to 
place or click and drag to the board. 
 
Double-clicking will attempt to open it in 
Pattern Editor Software. 
 
Place the Raygun pattern onto the board 

 

With the Raygun pattern still highlighted, change its length dimension to 9”, set its height to 999, and set the depth to 
.25”.  All of these variables can be found in the size box on the top toolbars. 

 
 

 

Click on the “Atom Logo” in the pattern 
library and place it on the board in front of 
the Raygun 

Set its depth to .25” 

 
Rotate the Raygun pattern slightly.  You 
can do this by using grabbing and dragging 
the center green handle  

 

OR by inputting an angle in the Angle Input 
Box on the toolbar. 
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ü CREATING A RAISED REGION 
 
With the connected line tool, draw a 
tapered shape coming from the Raygun to 
the Atom logo.  
 
 
 
 
 
 
 
 
 
 

 
ü CARVE REGION  
 
Select “Carve Region” icon and set the 
depth to .2”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
ü CHANGE DISPLAY 
 
Using the icons in the view toolbar, toggle 
texture off, toggle grid on, and toggle the 
snap to grid. 
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ü CREATING A RAISED REGION 
 
Select connected line tool again and draw 
starburst shape centered to the lower left.  
 
 
 
 
 
 
 
 
 
 
 

 
ü CARVE REGION  
 
Select “Carve Region” icon and set the 
depth of the starburst to .23”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
ü TEXT TOOL 
 
Next, select the “Text Tool” and click on 
board. 
 
Text dialog box will appear.  Choose your 
font and type the name of your Raygun 
and click on OK (We call ours 
MAAARAUDER and use a font called 
Bend2Squares downloaded for free from 
urbanfonts.com) 
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Select “Raster” from one of the available 
Rout Modes. 
 
Scale the text and position it on the board. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Add more text where desired using the 
above steps. (The other font used is 
Neuropol and was free at dafont.com) 
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ü USING THE CARVING LIST 
Now with all your text placed, open the 
caving list by selecting the “carving list” 
icon on the toolbar. 
 
 
 
From the carving list, select all of the text 
elements.   

Set their depth to .25” and the height to 
50. 

 
 
 
 
 
Set the draft of the text to medium using 
the “Draft” icon found on the toolbar. 

 
 
 
 
 
 
 
 
 
 
 
 
ü CREATING A TEXTURE  
 
Select the background region that you 
created earlier and select the “texture” 
icon from the toolbar 
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The Texture dialog box appears displaying a variety of 
available textures. 
 
Select the Vertical Waves texture and set the interval to 
.25” 

Click OK. 
 
 
 
 
 
 
 
 
 
 
 
The texture appears in the rectangular 
region, but is overtaking parts of the 
design. 
 
Correct this by adjusting the Height to 
“10”. 
 
 
 
This sets the height low enough to not 
overpower the foreground objects. 
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ü GROUP PATTERNS  
 
In the carving list select everything that is in it and select the group button at the bottom of the 
list. 
 
 
 
 
 
 

 
 
 
 
 
ü MANAGING DATA 
 
Save the project as Raygun box lid and 
we'll revisit it in a later project. 

Select “File” > “Save” 
 
 
 

*****IMPORTANT***** 
Once a project is uploaded to a memory 
card, it cannot be brought back from the 
memory card into the software.  Always 
SAVE YOUR PROJECT on your hard drive.  
A Projects folder is recommended and 
you should know where you saved it. 
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This project covers the following design concepts: 
 
Ø DRAWING TOOLS 
Ø SNAP TO GRID 
Ø SETTING CONSTRAINTS 
Ø CUT PATH TOOL 
Ø CENTERLINE TEXT  
Ø COPY & PASTE 
Ø FLIP & ROTATE 
Ø CREATING A CLOSED REGION 
Ø MANAGING DATA 
Ø STAYING UNDER ROLLERS 
Ø UPLOADING TO MEMORY CARD 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

INSTRUCTIONS: 

HOUSE NUMBER SIGN 
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Ø STARTING THE SOFTWARE 

 
Open the CarveWright Designer 

Software 
 

The Welcome screen appears with 
project options.   

 

 
Select “New Project” 

 
 
 
 

Set your board piece dimensions.   
Length: 12” 
Width: 5.5”  

Thickness: .75”    
 

Click ok 
 
 
 
 
 
 
 

Ø BOARD SETTINGS 
 

  Use “Toggle Texture” to 
remove wood grain for better 

viewing.   
 
 
 

Ø SNAP TO GRID 
 

Go to the menu bar and click 
“Layout” then select “Snap…” 
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From the “Snap to Grid” dialog 
box change the “Snap Interval” to 

“.025”. 
 

Check Snap Objects to Grid; Snap 
Objects to Edges; View Grid & 

Center Grid 
 

Click “OK” 
 
 
 
 
 
 
 
 
 
 

On your work piece you should 
now see a set of grid lines. 

 
 
 
 
 
 
 
 

ü DRAWING TOOLS 
 

 
Select the “Line Segment Tool”. 

Draw a horizontal line on the 
board on the second gridline from 
the top.  The vertical green arrow 

shows the distance from the 
element to the top (or edge) of 

the board.  Move the element or 
change the number to”0.5”.  
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ü CONSTRAINTS 
 

In the “Length” box or with the 
Blue Number type “8.0” and press 

Enter. 
 
 
 
 
 
 

ü DRAWING TOOLS 

    
Click on the “Circle Drawing Tool” 

drop down menu and select the 
“Arc Tool”.   

 
With your mouse pointer place 

your cursor over the left red node 
on your horizontal line.  

 
 When done correctly it should 

give you a visual notification that 
you are connecting the two 

drawing methods.  
 

 When you see the connected 
notification, left click once.  Now 

count two grid lines to the left and 
two grid lines down and left click 

once. 
 

At this point, we will not set the 
arc radius. 

 

 
Select the “Arc Tool” 

again.  Do the same to the 
right side of the line 

segment. 
Your shape should look 

like the top part of a 
trapezoid. 
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Right click on the line and select 
“Center”, “Center Horizontally” 

 
 
 
 
 
 
 
 
 
 
 
 
 

ü COPY & PASTE 
 

Select the line segment that was 
just created.  Copy it and then 

paste. 

 

 

 

 

   

ü FLIP & ROTATE 

With only the pasted line segment 
selected, Right click and select 

“Flip & Rotate”, “Flip Vertically”.  
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Now move the copied line to the 
second grid line from the bottom.   

 
There should be two line 

segments in the Carving Tree. 
 
 
 
 
 

ü CONSTRAINTS 
Constraints are given to guarantee 

a uniform project layout.   
 

On both line segments, set the 
Constraints for Center of the 

Board and Edge of the Board to 
“0.0”.  

 
NOTE:  Changing the number 

applies a “Constraint” and the 
number indicates this by turning 

yellow. 
 

Note: To remove or edit a 
constraint, right click on the 
number and select remove. 

 
 

 
Select the Arc Tool and connect to 

each red node on the left side of 
the work piece. 

Note: If connection is successful, 
the Carving Tree will show only 

one Line Segment. 
 
 

Repeat prior action with the right 
side of the design project. 
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ü CREATING A CLOSED 
REGION 

 
The shape should now be 

completely connected (“closed 
region”). 

   
ü CUT PATH TOOL 

 
Note: Region is not fully 

connected, if “Cut Path” option is 
not available when the element is 

selected. 
 

Check each red node to make sure 
they are fully connected. 

 

 
Go to View and select “Toggle Grid 

Lines” 
 
 
 
 
 

ü SETTING CONSTRAINTS 
 

Start with the upper left arc.  Left 
click the green node and drag it 

toward the upper left of the 
board.  Depending on how far you 
dragged your arc, your radius (R=) 

will vary. 
 

  Left click on your radius (R=#) 
and a box will open where you can 
constrain your radius.  Type “.8” in 

the box and press Enter. 
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Repeat this step to constrain the 
three remaining corners to “.8”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

To change the radius on the 
vertical arcs, Left click and drag 

the left green node to the edge of 
the board.  Once you have an arc 
left click on the radius (R=#) and 

change it to “1.95”. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Repeat this step to constrain the 
other vertical arc to “1.95”. 
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ü CUT PATH TOOL 
 

 
Select the “Cut Path Tool”. 

 
  In the “Cut-Out Control” select 

“Flip Cut”, “Hide Cut-Out” and 
“Accept”. 

 
“Flip Cut” changes the cut path 

from the inside of the vector line 
to the outside of the line.  When 
cutting out carved patterns, the 

outside is preferred for better 
results. 

 
 

ü TEXT TOOL 
 

 
 

Select the “Text Tool”.   

Click anywhere on the board. 

Select the following options: 

Font = “Century” 
Justification = “Center” 

Text = (Your house number) 
Rout Mode = “Centerline” 

 
Select “OK”  

Right click on the newly added 
text and select “Center”, “Center 

Both”. 
 
 
 

To resize the address simply click 
and drag any of the red nodes. 
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Once the address is the size you 
like, save the project. 

 
Select “File”, “Save”  

 
*****IMPORTANT***** 

Name file and click “Save” to hard 
drive. 

 
Ø UPLOADING TO MEMORY 

CARD 
 

 
Select “File”, “Upload” 
Save to memory card. 

 
Ø STAYING UNDER ROLLERS 

Note:  The Auto-Jig option may 
appear when uploading to the 

memory card.  Auto-Jig scales a 
project according to a 

predetermined set of dimensions 
to avoid possible errors.  In this 
case the board we setup in the 

software is 12”. The actual piece 
that should be inserted into the 

machine needs to be at least 19” 
to stay under the rollers.  

Therefore, select “Ignore”. 

 
Example: 

streetnumbersign_N_13 
 

(recognizable name_quality 
setting_estimated time to carve) 

 
 
 
 
 

 

 

 



 

122 | P a g e  
 

 

IMPORTING IMAGES AND MAKING LITHOPANES 
Project Designer always comes with an import image function.  This importer, 
accessed from the file menu, allows the import of several bitmap, or raster, image 
type.  The file types that can be uploaded are the following: BMP, JPG, JPEP, PNG, 
MNG, GIF, XPM.  The most common of these formats used are the JPG and PNG 
formats, which are the standard image files found on the internet and produced by 
digital cameras.  

 

Images can vary greatly in resolution, so it is important to understand what it is in 
order to pick proper images for importing. Resolution in digital images is described 
by pixels. Raster, or bitmap, images are composed of rows and columns of 
individual squares referred to as pixels.  The size and number of these pixels 
determine the resolution. The rows and columns of pixels are described as width 
and height, and the size of the pixels is described as PPI (pixels per inch).  The 
higher number of pixels an image has, the higher resolution it is. It is important to 
use the highest resolution images you can for good quality carvings.  It is important 
to note that you cannot add pixels to an image to increase resolution.  An image 
can always be reduced, but never enlarged without losing image quality.  

For example; the CarveWright carves at a resolution of 128 ppi. So if I were to 
make an 8”x10” lithopane, I would need an image of 1024x1280 for the best 
quality carve. 

The next two tutorials in this section describe the process of importing images and 
making lithopanes. 

 

 

 

RESOLUTION 
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This project covers the following design concepts: 
 
ü IMPORT IMAGE 
ü SELECT CROP 
ü 3D VIEW 
ü CHANGING DEPTH 
ü LOWER TO REMOVE IMAGE BACKGROUND 
ü SAVE ITEM 

 
 
 
 
 
 
 
There are several different types of images that can be imported into the Designer 
software and made into patterns.  Besides various file formats, there are different 
types of images from logos to clipart to photographs to scanned drawings.  As 
unique and different as they may be, so too, are their challenges.   This Design 
Project aims to assist you in overcoming some of the basic challenges. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

IMPORTING IMAGES 
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The Designer software comes preloaded with over 50 quality patterns to use in your project designs.  There are 
also over 7,000 patterns available on the CW PatternDepot in virtually any subject imaginable.  Add to that the 
ability to import digital images and the possibilities with your CarveWright Designer Software become endless. 
 
BASIC IMAGE INFORMATION : 
 
A digital image is a numeric respresentation 
(normally binary) of a two-dimensional image.  
(Wikipedia)  
 
ü IMPORT IMAGE 
 
Open Designer Software. 
 
Go to “FILE > IMPORT > IMPORT IMAGE FILE”. 
 
Navigate to wherever your image is located on your 
computer. 
 
***IMAGE FILE TYPES & RESOLUTION*** 
 
The basic Designer Software can import various file types.   These file types are considered “raster” and are made up of 
pixels, rather than geometric shapes (vector). 
 
Ø .png  
Ø .jpg (.jpeg) 
Ø .bmp (bitmap) 
Ø .gif 
Ø .mng 
Ø .xpm 

 
Image resolution is the detail an image holds. There are 
several types of resolutions, but importing higher 
resolution images results in better quality patterns.   
 
Digital images come from a variety of sources.  Some of 
these may not be satisfactory to use or may require 
additional “clean-up” to be of usable quality.  
 
The Internet is a great source for variety, but remember, 
images on the internet are usually low resolution, so that 
they will load onto your computer screen faster.  Some 
digital photographs are very high resolution. Scanned photographs have other issues, such as low resolution flatbed 
scanners, poor quality image being scanned, debris on scanner or defects on image.  Scans of hand-drawn images also 
take into account how hard or lightly you are pressing down on the pencil.  
 
A high resolution logo from your customer is much better than a customer’s company logo pulled off of their website. 
 
Select the image you want to import. Click “Open”. 
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ü SELECT CROP 
 
During import image, you can crop your image. (Licensed patterns cannot be cropped in this method. For those we use 
the “clip carving” function.)  
 
To crop, hover over the dotted yellow line until you get the 
double ended arrow, then Click and Drag to frame the image, 
however you would like to crop that image.   
 
Converting a 2d image into 3d has presented itself as 
quite a challenge, and is almost impossible as there is 
simply not enough information in a flat 2d image to 
make it true 3d.  The Designer software gets you close by 
converting your 2d image into a grayscale and 
“assigning” a carving depth based on that grayscale. 
White gets the deepest carve and black the shallowest.  
There are 254 levels of gray inbetween that make up the 
detail.  This conversion takes place by clicking the NEXT 
button.  
 
Click “Next”. 
 
ü 3D VIEW 

 
There are several things you can do to manipulate your pattern at this point in the import process: 
 
Zoom & Rotate:  The Pattern View window that is the larger area on the right side will allow you to ZOOM or ROTATE the 
pattern to get a better view of it. 
 
Size:  The image width and height can be changed. The lock 
keeps the pattern in proper aspect without skewing it. 
 
Depth:  The depth is the size difference between white & 
black.  Default is always .25, but you may often want to 
narrow the difference for a smoother transitioning pattern by 
lowering the depth. 
 
Raise / Lower:  Raise moves the pattern up and eliminates the 
top layers (default is black).  X resets it to the original. Lower 
moves the pattern down and eliminates the bottom layers 
(default is white). 
 
Invert:  Changes the pattern to white on top and black on 
bottom. 
 
Floor Edges:  Floor edges should be left on to keep the edges 
all at the same depth for consistent feathering of the pattern. 
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This image technically should have two levels – white and black.  White is the deepest & black is the shallowest by default 
unless you selected Invert.  
 
ü CHANGING DEPTH 
 
Change depth to 0.1 or leave for thicker pattern.  
 
ü LOWER TO REMOVE IMAGE BACKGROUND  
 
Click the down arrow once to remove the white background.   
 
If it is not a pure white background, you may need to click 
several more times to get rid of most of the background that 
you do not want.  Pattern Editor (advanced software 
purchase required) may need to be used to clean up some 
patterns. 
 
Select “Finish”. 
 
ü SAVE ITEM 
 
Select the location in your Pattern Library Favorites folder (or create a New Category), where you want to save your new 
pattern.   
 
Name the pattern. 
 
Select “Save”. 
 
Now you can use the new pattern in your projects or use the shape of it to make cut-outs.  
 
EXPERIMENT TO FIND A PATTERN THAT WORKS: 
 
 

This is the image with multiple  
 

layers of gray. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This is the pattern imported with NO manipulation. 
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This is the same pattern viewed from the side. (EEK!) 
 

 
 
 
 

 
 
 
 

 
This is the pattern after being manipulated. 

 
 
 

 
 
 

Here is another option. 
 
 
 
 
 
Other manipulation can be done using advanced 
software such as Pattern Editor, 2d Vector Drawing 
Tools & 3d Pattern Modeling. 
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CREATING A LITHOPANE 
Adopted from Tips & Tricks article; Lithopane 101 by Jason Allen and edited by 
CarveBuddy 
 
History: Originally Lithopanes (lithophanes) were made as a part of a piece 
of porcelain, typically the bottom of a cup or mug so the user would see the 
image when the cup was empty. 
 
It was created as a wax original by an artist who carved the wax to create 
thin and thick areas that would represent light and dark areas. This wax 
original went through several steps to end up as a part of the piece of 
porcelain.  
 
Our modern Lithopanes are made using editing software and carving or 
CNC machines. The lithopane itself is carved from a sheet of translucent 
material (usually ¼ of an inch thick). The carving creates the light and dark 
areas due to the variations in thickness. By carving away the material, an 
image can be formed that is visible when lighted from behind. 
 
Like a stained glass window, a Lithopane needs to be illuminated from 
behind to reveal the image. Illumination may be provided by an 
incandescent or fluorescent light, candle light, or sunlight. Direct sunlight is 
not needed -- the light from an overcast day will provide adequate back 
illumination.  
 
The Lithopane can be used mounted or unmounted. There are a number of 
mounting methods, some of them include: 
 
1) Mounted in a box with back lighting 
2) Attached to a suction cup to hang in a 

window 
3) As a part of a piece of stained glass art 
4) In the base of a lamp 
5) Inserted in a frame 
 
Although the first mounting style is commonly 
used as a night light, the image can be viewed 
in normal room lighting using a 9 watt “puck” 
light for back illumination, available for around 
$10 at any home improvement store. 
 
Size: In theory, the lithopane can be made in any size, but there are 
practical limits. Because the width of the CarveWright is limited, the 
maximum width is about 14". They look great in standard 4x6, 5x7 and 8x10 
sizes but you can make whatever size you wish. 
 



 

129 | P a g e  
 

Our largest lithopane was used on the Cpl. Jason Dunham memorial and it 
measured 14” x 28” (fig. 1) As long as you stay within the 14.5” maximum 
width of the CarveWright, you could honestly make a lithopane 8 feet in 
length. 
 
Color/Tint: The material that Lithopanes are made of comes in a variety of 
colors. In sunlight, using a white material, the color/tone of the Lithopane 
can be similar to a black and white photograph. Using a Bone or off-white 
color yields a sepia tone (antique-looking) photograph. The effect depends 
upon the color of the material being used. When used as a night light, an 
incandescent bulb will give the lithopane a warm tone. For larger 
Lithopanes, fluorescent lighting may be used and will provide a more neutral 
tone. 
 
Need some ideas of how to pose your subject? Browse “stock photo” sites 
that are in business to sell the rights to photos. The contributors to these 
sites are amateurs and professionals that have uploaded their photos for 
use by others. It costs nothing to look --- just search by the type of subject 
(like “baby”, “dog” , “deer”, etc.). Looking at how the pros compose a 
photograph can give you some good ideas on how to compose your own 
photos. 
 
Zoom in on the subject -- try to make the photo sized as close as possible 
to the finished product that you want to achieve. 
 
Use a white or light-colored background -- this will make the subject 
stand out. 
 
Save pictures at the highest resolution allowed -- too low of a resolution 
will decrease the sharpness and quality of the lithopane. 
 
Image Requirements: To make a good lithopane, a good digital image is 
needed. The best source is from a digital camera, but it is also possible to 
scan a photograph. If you scan and/or edit an image, be certain to save it at 
the highest resolution possible. 
 
Crop or Zoom In on the Subject: 
Cropping an image is done to draw 
attention to the subject. This will also 
eliminate a good amount of any 
unwanted background. (You can crop 
an image when you import your image 
into the Designer software that is 
included with your CarveWright 
machine) There are limits to how much 
the subject can be enlarged, 
depending upon the resolution of the 
photo -- as you zoom in, the pixels in 
the final image tend to become 
“blocky”, which reduces the sharpness 
of the final carving. 

SUGGESTIONS 
FOR 
PHOTOGRAPHS 
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Editor: For the “techies”, here is a general guide for the recommended 
maximum size litho using various megapixel settings. At different 
resolutions, some cameras offer an option to choose different image 
qualities. For the “non-techies” simply select “best” and you’ll be able 
achieve great looking lithos.  
 

 
The more pixels in the image file, the higher the resolution. Here’s an 
example of a digitally scanned photo at an original 2400 x 3000 resolution.  
 
Isolating the Subject: Many times it is desirable to isolate the subject 
(crop) from the background. First the background is removed around the 
image (this can done using the Pattern Editor software that is included with 
the scanning probe or with any photo editing software), then it is often best 
to “Feather” the edge to soften it. 
 
Composite Images: Isolated images also make it possible to make a 
composite of several individual images. This is useful if two (or more) 
subjects are to be combined from different photos or rearranged to 
different locations on the same photo. 
 
Avoid Low-Quality Images: Images that have been compressed for email 
or websites may have a reduced quality that may look fine for onscreen 
display, but are not suitable for lithos. In either of these cases, if it is 
necessary to use such an image it will be best to check with the original 
owner of the image, to see if a highquality (hi-res) image is available. The 
net effect of using low-quality/low-resolution images will be that the 
lithopane will not be as sharp as when the original image is used, and may 
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suffer from jpg artifacts (defects) that occur when an image has been 
compressed for the web or email. 
 
Scanned Prints: As a general rule, if the lithopane image is to be made 
from a scanned print (photo), the image on the print should be at least the 
same size as the lithopane. 
 
Professional Photographs and Artwork: The Federal Copyright Act 
provides protection to authors and artists for their original works, including 
photos and drawings. Among the protections that copyright owners have is 
the exclusive right to make copies of that work and prepare other works 
based on the original. You should “steer clear” of using material that is 
covered by copyright. In order to make a lithopane from a copyright 
protected item (regardless of whether it is marked with the © symbol or not), 
permission must be granted by the owner. The owner is the photographer, 
artist or the company that he or she works for. 
 
Ladies and gentlemen this is truly a simple process, every Lithopane that we 
have produced has been created and edited using just the software that is 
included with our CarveWright machine and scanning probe (the scanning 
probe software is not necessary to make great lithopanes). 
 
Our Process: The process starts with a digital photograph. The digital 
photo is imported into the Designer software, where the software will convert 
the image to as many as 256 shades of grey and build a “height map” image 
from it. The digital information from this image provides the depth value for 
the shades of grey in the image.  
 
The Designer software reads the image data and converts each pixel value 
into a depth to be carved into the material you are using, typically it is some 
type of cast acrylic material (Corian®, Staron®, Meganite™). These 
materials are opaque at normal thicknesses, but as the thickness 
decreases, they becomes more and more translucent. This effect duplicates 
the light and dark areas in the photograph. The carving cane be done using 
the 1/16” Carving bit that came with your CarveWright machine and takes 
anywhere from 35 minutes to 2 hours depending on the quality setting you 
select (good lithopanes can be produced using the “draft” setting but for 

better results use “best”).  With 
Designer PRO, the 1/32” Carving 
bit is an available option for 
achieving even higher detail. 
 
 
 
 
 
 
 
 
 

THE ART OF 
MAKING 
LITHOPANES 
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Use the following 9 steps and you will be making great Lithopanes that 
can be cherished for many generations to come! 
 
STEP 1 

Decide on the image that you would like to 
make into a Lithopane. 
 
STEP 2 
Start your Designer software, then click on 
“File” and scroll down to “Import Image” click 
again - this will open the “Import Image” 
window that asks you for the source of your 
image (i.e., where it is located) - you are given 

two options “From File” or “From Clipboard”. Select 
the appropriate option. 
 
STEP 3 
If you click “From File”, which is common, navigate to the photo file location. 
 
STEP 4 
Select the photograph you would like to edit and double click on it, or simply 
click “Open”. 
 
STEP 5 
The Designer software will import it into the “Import Image” window - here 
you will be able to crop the image to select the part of the image that you 

would like to make 
your Lithopane from. 
 
You can select any 
part of the photo 
(called cropping) by 
clicking and dragging 
on the dashed yellow 
box that is around 
the photo or image. 
 
STEP 6 
Once you have 
finished the cropping 
of your image, simply 
click the “Next” 
button located at the 
bottom of the “Import 
Image” window - 
doing so will convert 
the window over to 

the “3D View” window and will also do the magic of converting your image 
into the “height map” that will be used to produce your Lithopane. At this 
point you have some editing options “Raise”, “Lower” or “Invert” the image - 
we recommend you do none of these - just click the “Finish” button. 



 

133 | P a g e  
 

Give your image a name in the 
“Save Item” window and click 
“Save”. The image is now a 
CarveWright pattern (ptn) and 
can now be found in your 
pattern library by clicking on 
the blue shell at the top of your 
Designer software. 
 
STEP 7 
Click on the blue clamshell to 
open your pattern list, find the 
pattern that you just created 
from your image, click on it, 

then click on 
your board, 
place the image pattern on the board as you desire. 
 

STEP 8 - Setting Depth and Height 
The settings that we use are as follows - set your depth to .180 and the 
height to 450 - these settings will give you a nice, bright Lithopane that can 
be enjoyed at all hours of the day (it can be viewed in daylight when 
mounted in a backlit box). 
STEP 9 
Save your project as an mpc file with any name you choose, then upload 
your project to the memory card when you're ready to run the project at the 
machine. 
 
Lithopane Results: 
This 8x10 carving was 
done on Bone Corian 
from the CarveWright 
Store. Runtime was 59 
minutes on BEST 
quality setting. 
 
The pictures here don’t 
do the lithos justice - 
you have to see one up 
close, and in person to 
appreciate the detail 
and marvelous 
backlighting effect. 
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Most litho carving is done on 1/4” thick material, which is too thin to feed 
through the machine. Therefore, it is necessary to construct a jig (sled) for 
the material to be placed into. The jig will add to the overall thickness to 
meet/exceed the minimum 1/2” needed for the machine.  
 
Making a jig for carving on cast acrylic is very simple. Perhaps the easiest 
way to make your jig is to use your CarveWright/CompuCarve.  
 
Go to your local Home Center and buy a piece of 3/4” thick MDF (Medium 
Density-Fiberboard). Next, cut the piece to your desired dimensions. For this 
example we will use a 24” Long x 12” Wide x .75” Thick piece of MDF, and 
will create a jig to fit a sheet of 1/4” thick acrylic up to 11” x 17”. A common 
size is 8x10.  
 
Feel free to adjust the jig size and the 8”x10” recess dimensions to 
accommodate whatever size acrylic sheet you require. Just be certain that 

the overall size of the jig is a 
minimum of 7” longer than the 
acrylic you will carve on. This is 
essential so the jig will always be 
captive under the compression 
rollers. 
 
Create a new layout in Designer 
with a virtual board measuring 17” 
Long x 12” Wide x .75” Thick. (The 
virtual board is 7” shorter than the 

real board you place into the machine, which in this case will be 24” long).  
 
Draw an 8”x10” rectangle on the board and use the CENTER BOTH 
function to place the rectangle deadcenter on the board. (In our example, 
the jig will actually be 14” longer than the actual acrylic piece.  
This will allow you to create a rectangle recess up to 11” x 17” if desired.) 
Make the rectangle a CARVE REGION with a depth of .25”. This is the 
recess that your acrylic sheet will be placed, so it will sit flush with the top of 
the jig’s surface. 
Save the project, 
then upload it to 
your memory card 
and run the project 
on the 24” long 
MDF board. Once 
completed, you 
now have a jig to 
hold your cast 
acrylic sheet. 
  

MAKING A 
“SLED” OR “JIG” 
FOR LITHO 
CARVING 


